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Chapter 16: Molecular Methods for B. pseudomallei Bacterial Strain 

Typing 
 

Chapter Overview and Introduction to B. pseudomallei Strain Typing 

Bacterial strain typing, or the classification of different genetic variants of bacterial species, is 

important for disease diagnosis, treatment, and epidemiological surveillance. This is particularly 

relevant for bacteria exhibiting high levels of pathogenicity and virulence, including B. pseudomallei. 

B. pseudomallei is classified as a Tier 1 select agent by the US Centers for Disease Control and 

Prevention (https://www.selectagents.gov/). Potential outbreak scenarios thus warrant rapid public 

health response and high-resolution tools to quickly investigate source etiology.  

 

In endemic regions, individual cases of melioidosis are typically the result of infection by a single 

environmental isolate of B. pseudomallei. Despite this, clonal or “point-source” outbreaks have been 

described on several occasions, including contamination of drinking water supplies in two remote 

Indigenous communities from Northern Australia (Currie et al. 2001; Sarovich et al. 2017), 

contaminated hand-washing detergent (Gal et al. 2004), as well as cases traced to domestic water 

wells/bores (McRobb et al. 2015). A handful of outbreaks have also been described in non-endemic 

settings. One of the most notorious of these outbreaks took place at a Paris zoo between 1975 and 

1979. Aside from infecting numerous animals at the zoo, several horse and human melioidosis cases 

elsewhere in France also occurred as a result (Mollaret 1988). Outbreaks are also frequently 

reported in non-native animal species in endemic regions, such as in slender-tailed meerkats from 

Thailand and north Australian zoos (P. Kongmakee 2015; Rachlin et al. 2019), marine mammals from 

a Hong Kong Ocean Park (Hicks et al. 2000), exotic birds (Hampton et al., 2011), as well as numerous 

non-human primate species (Sim et al. 2018).  
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The following chapter discusses several of the more widely used methods for B. pseudomallei 

molecular strain typing, with specific protocols provided for multi-locus sequence typing (MLST), 

multilocus variable number of tandem repeats analysis (MLVA) and BOX-PCR. An overview of whole-

genome sequencing (WGS) technology and its future implications for bacterial source-tracing are 

also presented at the end of the chapter. 

 

General Approaches to Bacterial Strain Typing 

A variety of molecular typing methods have been designed for epidemiological investigations of 

bacteria and for examining bacterial population genetics. Some methods are more useful for 

examining localized outbreaks, while others are more suitable for determining the global or long-

term evolutionary relatedness of strains (Chan et al. 2001; Maiden et al. 1998). Several current 

approaches to B. pseudomallei strain typing include: 

1. Multilocus sequence typing (MLST) – MLST involves sequencing 400-600 base pair fragments 

of DNA at seven different conserved genes. It enables small variations within a species to be 

detected. The method is highly discriminatory and can be used to compare the relatedness 

of isolates globally, but can be both time consuming and expensive, making it impractical for 

rapid outbreak scenarios (Maiden et al. 1998).  

2. Multilocus variable number of tandem repeats analysis (MLVA) – MLVA is a molecular 

fingerprinting method based on PCR amplification and sequencing of repetitive DNA 

sequences termed “variable number tandem repeats” (VNTRs). It generates a specific MLVA 

pattern that is unique to the bacterial strain being investigated. MLVA is quicker to obtain 

results than MLST, however there are issues with reproducibility and inter-laboratory 

comparison (van Belkum et al. 1998). 

3. Repetitive sequence-based PCR (rep-PCR) – Bacterial genomes contain multiple non-coding, 

repetitive regions of DNA. Rep-PCR uses these repetitive sequences to produce fragments of 

variable sizes. These can then be separated using gel electrophoresis, producing a 
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characteristic pattern of bands, sometimes called a genetic “fingerprint”. One type of rep-

PCR frequently used for B. pseudomallei is the BOX-PCR (Versalovic et al. 1991). 

 

For local outbreak investigations, molecular typing and fingerprinting methods that are highly 

resolving are necessary to distinguish small differences in genetically related strains. These types of 

assays are also useful for distinguishing small genetic changes during sustained outbreaks. The 

methods that have been used for this purpose include BOX-PCR and multiple-locus variable-number 

tandem repeat analysis (MLVA) (Maiden et al. 1998). During an outbreak or a cluster of cases, rapid 

high-resolution fingerprinting methods can be used alongside epidemiological data and more 

conserved typing techniques, such as MLST, to help discriminate and determine the relationship 

between isolates.  

 

B. pseudomallei Multilocus Sequence Typing  

Multilocus sequence typing (MLST) has become the most widely used method of B. pseudomallei 

strain typing globally, as it indexes variations within fragments of seven housekeeping genes that are 

selectively neutral. This allows for easy interlaboratory comparison and simple, unambiguous strain 

characterization (Maiden et al. 1998). Different allele numbers are assigned to each of the seven 

housekeeping alleles based upon point mutations that occur within each gene. Once assigned, the 

allele numbers of each of the housekeeping genes are arranged into a string of seven numbers to 

produce an allele profile. The allele profile corresponds directly to a specific sequence type (ST). An 

online MLST database has also allowed for standardization of strain types and has conferred the 

ability to analyze evolutionary relatedness between isolates (Maiden et al. 2013) 

(https://pubmlst.org/organisms/burkholderia-pseudomallei). Typing of B. pseudomallei using MLST 

scheme is useful to explore sequence type diversity in a particular geographical area (Cheng et al. 

2008), track the source of melioidosis outbreaks (Inglis et al. 2000) and define whether recurrent 

https://pubmlst.org/organisms/burkholderia-pseudomallei
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melioidosis is due to a relapse of the same bacterial ST or reinfection with a different ST (Maharjan 

et al. 2005; Rachlin et al. 2016). 

 

The MLST scheme specific for B. pseudomallei was originally developed by Godoy et al. in 2003 and 

employs seven house-keeping alleles 400bp-600bp in length (Godoy et al. 2003; McCombie et al. 

2006). The scheme has now been used to identify more than 1900 B. pseudomallei MLST sequence 

types (as of March 2021). In recent years, whole-genome sequencing (WGS) has provided a rapid 

alternative for extracting MLST profiles; however, the PCR-based Sanger sequencing method for 

MLST is still used by many researchers across the globe. 

Figure 98- Schematic diagram of the typical bacterial MLST protocol. Allele numbers are assigned to 

each of the seven PCR amplified housekeeping gene fragments giving an allele profile for a bacterial 

isolate. Examination of the online MLST database using the allele profile results in ST assignment 

(Ruppitsch 2016).  

 

B. pseudomallei MLST Protocol 
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General Comments Before Starting  

PCR is very susceptible to contamination and additional precautions should be taken to minimize 

cross-contamination: 

• Where possible, separate the areas where different PCR steps are performed, including PCR 

reagent assembly, addition of the DNA template, and detection of PCR products (see 

Chapter 12 for further detail).  

• If individual rooms are not possible, separate laboratory bench spaces should be used for 

these steps. Separate pipettes, laboratory coats and gloves should be used in each of these 

areas. 

• Working in a PCR laminar flow hood is also recommended to minimize cross-contamination. 

• Decontamination of surfaces and equipment with a 10% bleach solution or 

DNAerase/commercial decontaminant solution followed by 70% ethanol should be 

performed after any handling of nucleic acids at the laboratory bench. 

• Always use filter-barrier pipette tips and change and discard gloves frequently. 

• Remove DNA templates, controls and other reagents from the freezer and allow them to 

thaw completely before use. Briefly vortex and centrifuge tubes for 30 seconds at 1000 rpm 

before using. 

• It is good practice to keep reagents on ice while setting up the reaction plate and PCR master 

mix to prevent reagent degradation.  

• Prior to beginning the PCR, plan the experiment by filling out and printing a plate template 

worksheet (see example below). Ensure sufficient quantities of primer working solutions and 

other PCR reagents are available and have been correctly calculated. 

• Primer working stock solutions should be made up to 20 µM before starting. This will help to 

prevent primer contamination and limit repeat freeze-thaw cycles every time the reaction is 

performed.  
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• Care must be taken when interpretating results, particularly during inter-laboratory studies. 

Minor differences in electrophoresis conditions can change the distance bands migrate 

through the gel, confusing comparison between isolates. 

 

Equipment and Reagents 

• Primers (see Table 20 below) 

• PCR positive and negative controls  

• 10x PCR Buffer 

• 10mM dNTP Mix 

• Taq DNA Polymerase 

• Q solution (QIAGEN) or Betaine solution (e.g. Sigma-Aldrich B0300)  

NOTE- While not required, these additives are commonly used to enhance amplification of GC-rich 

sequences. 5% Dimethyl sulfoxide (DMSO) may also be used if these solutions are not available. 

• MgCl2 

• PCR-grade water 

• 10% bleach solution or commercial DNA decontaminant (e.g., DNAerase) 

• 70% ethanol 

• PPE (gloves, lab coats and safety glasses) 

• Laboratory pens/markers 

• Racks for 1.5mL microcentrifuge tubes 

• Pipettes and filter/barrier pipette tips 

• Sterile PCR microcentrifuge tubes 

• Benchtop microcentrifuge 

• 96-well polypropylene PCR plates (e.g. Thermo Scientific™ AB0600) or PCR strips (e.g. Axygen™ 

0.2 mL Polypropylene PCR Tube Strips #16272591)  

• PCR strip caps to cover wells 
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• Vortex 

• Thermocycler (such as Eppendorf Mastercycler® or T100TM Bio-Rad) 

 

Primers and PCR conditions for MLST of B. pseudomallei 

The following primers should be used for the amplification of the seven house-keeping gene 

fragments:  

 

Table 20- House-keeping alleles used for B. pseudomallei MLST. Gene functions, primers and product 

sizes are also shown (https://pubmlst.org/organisms/burkholderia-pseudomallei) (Godoy et al. 

2003).  

 

NOTE- Alternative primers for the B. pseudomallei MLST assay are also described by Price et al. 

(2016) J Med Microbiol 65:992–7. 

 

A. Preparation of DNA Template 

For each of the PCR assays described in this chapter, DNA must be extracted from the specimen 

before it can be tested. Molecular typing requires isolation of DNA from a pure bacterial culture. 

This is done to ensure there is only one bacterial isolate extracted in the event there is a mixed or 

Locus Gene function 

Product 
Size 
(bp) 

Forward Primer (5’-3’) Reverse Primer (5’-3’) 

ace 
Acetyl coenzyme A 
reductase 519 

5’-CGGCGCTTCTCAAAACGATA-3' 
 

5’-GAATCGCCTTCACCATGTC-3' 

gltB Glutamate synthase 522 
5’-ACGCTCGCGATCGCGATGAA-3' 

 
5’- TTCAGCACGAGCGTCTGCTG-3' 

gmhD 
ADP glycerol-
mannoheptose epimerase 468 

5’-GCAGTTCCTGTATGCGTC-3' 
 

5’-GAAGCACTGGTACTTGCC-3' 

lepA 
GTP-binding elongation 
factor 486 

5’-CATATTCGCAATTTCTCGATC-3' 
 

5’-CACGAGCATCACGACGCCG-3' 

lipA Lipoic acid synthase 402 
5’-GGCACCGCGACGTTCATG-3' 5’-GACCATCAGGCCCGATTTCG-3' 

narK Nitrate extrusion protein 561 
5’-CTACTCGTGCGCTGGGAT-3' 5’-GACGATGAACGGCACCCAC-3' 

 

ndh NADH dehydrogenase 443 
5’- AGTCGCGACGTTCTACAC-3' 5’- CGAGTTGCAGACGAGATA-3' 
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“polyclonal” infection and ensures that there is sufficient quantity of bacterial DNA for typing.  See 

Chapter 13 for specific protocols on DNA extraction from bacterial culture. 

B. MLST PCR Set-Up 

1. Create a plate map to keep track the samples being tested. An example of an appropriate plate 

map is shown below (Here, K96243 is used for the positive control). 

 

2.  Prepare the PCR master mix reagents in the designated PCR clean room/area. The master mix 

should include all reagents except the template DNA. This should be done for all 7 MLST 

alleles/primer sets to be tested. Ensure two additional reactions are prepared when calculating 

master mix quantities to account for reagents lost during pipetting. Reactions should be 

performed in 50 µL volumes either in 8-well tube strips or in 96-well plates. When setting up the 

PCR reactions keep reagents on ice to prevent degradation.  

 

Reagent 
Volume (µL) per 

Reaction Final Concentration 

PCR grade water 27.75 
 

10X buffer 5.0 1X final concentration 

25mM MgCl2 3 1.5 mM final concentration 

10 mM dNTPs 1 200 µM final concentration 

20 mM forward primer 1 0.4 µM final concentration 

20 mM reverse primer  1 0.4 µM final concentration 

Q Solution/Betaine Solution 10 1X final concentration 

Taq DNA polymerase  0.25 2.5U final concentration 

Template DNA 1.0 
 

Final volume 50.0 
 

1 2 3 4 5 6 7 8 9 10 11 12

A MSHR0338-5 K96243 MSHR7780 MSHR7781 MSMB0059 MSMB0263 MSMB0121 MSMB1588 MSMB0152 MSMB1011 NTC Blank <-- ace  locus

B MSHR0338-5 K96243 MSHR7780 MSHR7781 MSMB0059 MSMB0263 MSMB0121 MSMB1588 MSMB0152 MSMB1011 NTC Blank <-- gltB  locus

C MSHR0338-5 K96243 MSHR7780 MSHR7781 MSMB0059 MSMB0263 MSMB0121 MSMB1588 MSMB0152 MSMB1011 NTC Blank <-- gmhD  locus

D MSHR0338-5 K96243 MSHR7780 MSHR7781 MSMB0059 MSMB0263 MSMB0121 MSMB1588 MSMB0152 MSMB1011 NTC Blank <-- lepA  locus

E MSHR0338-5 K96243 MSHR7780 MSHR7781 MSMB0059 MSMB0263 MSMB0121 MSMB1588 MSMB0152 MSMB1011 NTC Blank <-- lipA  locus

F MSHR0338-5 K96243 MSHR7780 MSHR7781 MSMB0059 MSMB0263 MSMB0121 MSMB1588 MSMB0152 MSMB1011 NTC Blank <-- narK  locus

G MSHR0338-5 K96243 MSHR7780 MSHR7781 MSMB0059 MSMB0263 MSMB0121 MSMB1588 MSMB0152 MSMB1011 NTC Blank <-- ndh  locus

H Blank Blank Blank Blank Blank Blank Blank Blank Blank Blank Blank Blank
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3. Gently mix the master mix then briefly spin in a microcentrifuge. 

4. Pipette 49 µL of this master mix (for each MLST allele/primer set) into the appropriate well of a 

96-well plate or PCR strips, according to the plate template worksheet. 

5. Cover the wells using cap strip covers. Spray and wipe down the clean workspace with bleach or 

DNAerase and repeat this with 70% ethanol. Remove laboratory coat and gloves and put on a 

new pair of gloves. Carry the 96-well plate or PCR strips to the DNA template addition area. 

6. Put on a new laboratory coat while keeping the same pair of gloves on. Carefully remove the cap 

strip covers from the 96-well plate or PCR strips. Open these slowly to prevent aerosolization 

and spraying of any liquid in the wells.  

7. Add 1 µL of template DNA to each appropriate well of 96-well plate or PCR strip using the plate 

template worksheet for reference.  

8. Add 1 µL water to the ‘NTC’ well. 

9. Add 1 µL of the positive control DNA to the correct well. One positive control should be used for 

each master mix. 

10. Cover the wells of each column of the PCR plate or each PCR strip using strip cap covers as you 

go and secure caps tightly. 

11. Spray and wipe down the area with bleach or DNAerase and repeat with 70% ethanol. Remove 

laboratory coat and gloves. If possible, briefly spin the plate at 1000 rpm to bring down any 

liquid droplets. Transport the plate directly to the PCR thermocycler room/area and place it in 

the PCR thermocycler. 

 

C. PCR Thermocycler Set-Up 

1.  Set the following PCR cycle on the thermocycler: 

Stage Time Temperature # Cycles 

Initial denaturation 4min 95oC 1 

Amplification 
30sec 95oC 

35 
30sec 62oC 
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2. Double check all temperature and times are correct and press start.  

3. Once the reaction has finished, store the PCR products at 4°C until ready for subsequent product 

analysis or store at -20oC long-term.  

 

D. Analysis of PCR Products by Gel Electrophoresis 

It is useful to check for a successful PCR amplification using gel electrophoresis before beginning PCR 

product purification and sequencing.  

1. While the MLST PCR is running, make up an agarose gel (refer to Chapter 14- Conventional PCR 

for the full gel electrophoresis protocol).  

2. Once the PCR has finished running, turn off the PCR machine, briefly centrifuge the tubes and 

take the tubes into the post-PCR processing gel electrophoresis room. 

3. Carefully load 5 L of each DNA product (mixed with loading dye- 1-2 drops or approx. 2 uL) and 

the DNA ladder into the gel. 

4. Run the gel for approximately 45-60 minutes at 100V (check frequently to ensure the products 

do not run off the gel).  

5. Remove the gel from the tank and place on the gel doc to visualize the products. 

6. A strong band should appear for each sample to be sequenced. Ensure these bands are the 

correct size. Only a single DNA fragment should have amplified. This may involve some 

optimization of the PCR annealing temperature. Since B. pseudomallei has a high G+C content, 

the use of additives such as DMSO with betaine “Q-Solution” can help to improve the 

amplification of PCR fragments (https://pubmlst.org/organisms/burkholderia-pseudomallei). 

30sec 72oC 

Final Extension 10min 72oC 1 

Hold -- 4oC -- 
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Refer to the troubleshooting guide in Chapter 14 if any of the reactions do not display bands on 

the gel, if there are multiple bands present in one lane, or if bands are very faint. An example of 

how PCR products should look is shown in the figure below (Figure 99) (Price et al. 2016). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 99- Example of successful amplification of the seven MLST gene alleles. Here, an alternative 

set of B. pseudomallei MLST primers (see the reference for the alternative primers above) are used 

to amplify members of the Burkholderia pseudomallei complex (Burkholderia pseudomallei, 

Burkholderia humptydooensis, Burkholderia thailandensis). Members of the Burkholderia cepacia 
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complex (Burkholderia cepacia and Burkholderia ubonenesis) do not amplify across all seven alleles 

(Price et. al 2016).  

 

E. Purification of PCR Products  

To perform MLST Sanger sequencing, the amplified products must be purified before sequencing 

reactions can be performed. This is done to remove any unincorporated PCR reagents and dyes. 

Purification can be carried out using one of several commercially available kits, such as QIAquick 

(QIAGEN), which utilize spin columns to purify the products. Likewise, the reaction products can be 

purified by ethanol precipitation methods or PEG8000/2.5M NaCl precipitation. The inexpensive cost 

of reagents may make ethanol or PEG8000/2.5M NaCl precipitation a more practical option in 

resource-poor labs. See below for a simple protocol for PEG8000/2.5M NaCl purification.  

NOTE- Sequencing generally requires about 10ng of purified PCR product per 100 bp product size 

(e.g., for a 500 bp PCR product, about 50 ng of template is required for sequencing) (QIAGEN 1998). 

 

A protocol for QIAquick (QIAGEN) purification, can be accessed at: 

https://www.qiagen.com/au/resources/resourcedetail?id=e0fab087-ea52-4c16-b79f-

c224bf760c39&lang=en 

 

For PEG8000/2.5M NaCl Precipitation (Glenn 2021; Kusukawa et al. 1990): 

Materials- 

o 20% PEG (Polyethylene glycol), 2.5 M NaCl –  

▪ For 50mL, mix the following in a 50 mL conical flask: 

1. 10.0 g Polyethylene Glycol 8000 

2. 7.3 g NaCl 

3. Distilled H2O up to 50 mL –  

▪ Place into an incubator set to 37°C for 20 minutes. 

https://www.qiagen.com/au/resources/resourcedetail?id=e0fab087-ea52-4c16-b79f-c224bf760c39&lang=en
https://www.qiagen.com/au/resources/resourcedetail?id=e0fab087-ea52-4c16-b79f-c224bf760c39&lang=en
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o 80% ethanol  

o TLE = 10 mM Tris-HCl, 0.1 mM EDTA 

Procedure 

1. Add 50 μL of PEG to a sterile Eppendorf tube. Transfer the PCR product to the tube and mix 

thoroughly by pipetting up and down. 

2. Incubate the mixture at 37°C for 15 min. 

3. While the mixture is incubating, place the 80% ethanol on ice. 

4. Once the mixture has been incubated, centrifuge tubes at high speed (~15,000 x g) for 15 

minutes.  

5. Use a sterile pipette to remove the supernatant and discard it. 

6. Add 125 μL of cold 80% ethanol to the tube and centrifuge for two minutes. Carefully 

remove the supernatant with a pipette and discard. 

7. Repeat step 6. 

8. Evaporate residual ethanol using a speed-vac for 5-10 minutes or by opening the tube and 

leaving in a 37°C heat block. There should be no trace of the ethanol remaining. 

9. Resuspend the pellet in 25 L of distilled water or buffer of choice (e.g TEL buffer- Tris-

HCl/EDTA) or make up to the appropriate concentration required for sequencing. Pipette up 

and down enough so that the DNA has fully gone into solution.  

10. Laboratories should ensure they follow the protocols described by the sequencing platform 

being employed to ensure the correct concentration of product is sent.  

 

F. Sanger Sequencing of Purified MLST PCR Products  

The purified PCR gene fragments should be sequenced in both forward and reverse directions and 

then aligned using sequence alignment software. Sequencing each strand provides more confidence 

than if only a single strand is used to determine the base calls. The aligned sequences can then be 

trimmed to the correct length for comparison and examined for miscalled bases, insertions, gaps, 
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overlapping nucleotide signals and any sequence differences. High-quality sequencing is essential for 

MLST, as a single base pair change can result in a new allele number being designated (Maiden et al. 

2013).  

 

For B. pseudomallei MLST, the same 7 MLST primers are also used for sequencing that are used for 

PCR amplification. Primers should be diluted in PCR-grade water to a concentration of 10pmol/L 

before sending for sequencing. 

 

Preparing primer dilutions 

• The easiest way to prepare primer dilutions is to make a 1 in 2 (1:2) dilution of a 20 M primer 

stock.  

NOTE: 20 M = (20mol/L) x (1L/1000,000 L) x (1000,000 pmol/1mol) = 20pmol/L 

• Send 20 L of 10pmol/L for every 5 samples to be sequenced. 

 

Once the PCR products have been purified and primers have been appropriately diluted, they can be 

shipped to any commercial sequencing laboratory for standard Sanger sequencing (e.g. Macrogen, 

Seoul, Korea: 

https://dna.macrogen.com/pageLinkDnaSys.do?menuCd=SUP100200&layout=page_sub&link=%2Fs

upport%2FretrieveGuideCes#none.  

Ensure samples are appropriately sealed to prevent spillage or evaporation during transport and that 

sample information is filled out correctly based on the specific commercial sequencing laboratory 

being used. Sequencing can also be done in-house if available using commercially available kits (e.g. 

Applied Biosystems BigDye™ Terminator chemistry). 

      

G. Analysis of Sequence Data and Allele Determination 

https://dna.macrogen.com/pageLinkDnaSys.do?menuCd=SUP100200&layout=page_sub&link=%2Fsupport%2FretrieveGuideCes#none
https://dna.macrogen.com/pageLinkDnaSys.do?menuCd=SUP100200&layout=page_sub&link=%2Fsupport%2FretrieveGuideCes#none
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• After the data has been obtained from the sequencer, the sequencing files (also termed trace 

files) must be examined for incorrect base calls. The complementary strands must also be 

aligned and trimmed so they are the appropriate length. These aligned and trimmed sequences 

are called “DNA consensus sequences”- or a sequence of DNA that represents the most 

commonly encountered nucleotides found at a specific location. 

• Various computer programs can be used to assemble, align and edit the trace files from the DNA 

sequencer and can be used to create consensus sequences, such as CLC Genomics Workbench 

(QIAGEN) or ChromasPro (Technelysium- free online download).  

• Follow the specific software protocols to assemble and align the sequences.  

• Sequences that are inadequate in length (too short) or poor in quality (displaying two peaks at 

the same nucleotide position, or sequences exhibiting an inadequate concentration of DNA) 

should be discarded and the samples should be re-amplified and sequenced again.  

• Forward and reverse sequences that are high in quality can be aligned to create a consensus 

sequence for the seven housekeeping genes for each B. pseudomallei isolate.  

 

H. MLST Analysis 

Once consensus sequences have been created, they can be copied into the MLST website for allelic 

analysis and sequence type (ST) determination (https://pubmlst.org/organisms/burkholderia-

pseudomallei). The software examines if the sequences are the correct length and do not contain 

any unspecified characters. The user is then able to check the allele at a single locus, to enter an 

allele profile, to search for isolates in the database that match a specific allele profile, or simply 

browse the database. Sequences not already present in the database can be submitted to the 

database curator as a new allele. The database curator will then examine the sequence trace files 

and assign a number to the new allele profile to add to the database.  

 

https://pubmlst.org/organisms/burkholderia-pseudomallei
https://pubmlst.org/organisms/burkholderia-pseudomallei
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To check individual alleles:  

1. On the MLST website select “Single Sequence Query” 

(https://pubmlst.org/bigsdb?db=pubmlst_bpseudomallei_seqdef&page=sequenceQuery).  

2. Choose the specific allele to be checked and paste your allele sequence into the box. 

Alternatively, you can upload individual sequence FASTA files.  

3. Press submit. The number for your allele will be displayed at the top.  

https://pubmlst.org/bigsdb?db=pubmlst_bpseudomallei_seqdef&page=sequenceQuery
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4. Write down the number that is assigned to each allele. 

5. Go to “Search for Allelic Profiles by Specific Criteria”: 

https://pubmlst.org/bigsdb?db=pubmlst_bpseudomallei_seqdef&page=profiles&scheme_id=1.  

6. Type in the number for each allele and press submit to view the designated ST type. 

 

I. Submitting Data Using the Online Submission System 

The automated submission system allows users to submit data (new alleles, ST profiles, or isolates) 

to the database. The MLST curator will then assign new alleles or STs and upload them to the 

database. New submissions can be made by clicking the ‘Typing” followed by “Submissions” tab on 

the database front page.  

 

 

 

 

 

 

 

 

 

https://pubmlst.org/bigsdb?db=pubmlst_bpseudomallei_seqdef&page=profiles&scheme_id=1
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You must have an account in order to use the submission system. Once logged in, follow the 

instructions provided to submit MLST data. 

 

NOTE- For any questions concerning how to use the B. pseudomallei MLST database or 

submitting isolate profiles, email the database curator (email found on the B. 

pseudomallei PubMLST homepage https://pubmlst.org/organisms/burkholderia-

pseudomallei).   

 

J. Phylogenetic Analysis Using MLST Data 

The MLST online database has several links to various programs for further analyses. MLST data are 

frequently represented by a dendrogram (a tree diagram used to visualize evolutionary relationships 

and show the arrangement of clusters) using programs such as molecular evolutionary genetics 

analysis version-6 (MEGA 6) software (Tamura et al. 2013) (Figure 100) and eBURST analysis, which 

can be used to determine the evolutionary relatedness between isolates (Feil et al. 2004; Spratt et 

al. 2004) (Figure 101). A plugin for MLST eBURST analysis is available at 

https://pubmlst.org/bigsdb?db=pubmlst_bpseudomallei_seqdef&page=plugin&name=BURST&sche

me_id=1&l=1). The global optimal based upon related sequence types (goeBURST) program, part of 

PHYLOViZ software, can also be used to examine B. pseudomallei isolate relatedness using MLST 

https://pubmlst.org/organisms/burkholderia-pseudomallei
https://pubmlst.org/organisms/burkholderia-pseudomallei
https://pubmlst.org/bigsdb?db=pubmlst_bpseudomallei_seqdef&page=plugin&name=BURST&scheme_id=1&l=1
https://pubmlst.org/bigsdb?db=pubmlst_bpseudomallei_seqdef&page=plugin&name=BURST&scheme_id=1&l=1
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data. geoBURST allows for higher discerning clustering based on double and triple locus variants (e.g. 

the number of alleles that differ from the ancestral genotype) and incorporates global MLST data 

(Francisco et al. 2009). See http://www.phyloviz.net/goeburst/ for more information and download 

options. 

 

 

.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 100- Here, the evolutionary relatedness of B. pseudomallei clinical isolates from Malaysia is 

compared to India, China and Southeast Asian isolates using a dendrogram based on an Unweighted 

http://www.phyloviz.net/goeburst/


ASM/CDC Melioidosis Manual - 2022 

324 
 

Pair Group Method with Arithmetic average (UPGMA) method in (MEGA 6) software (Zueter et al. 

2018).  

 

Figure 101- Genetic relationship of 130 Indian B. pseudomallei isolates using eBURST analysis. 

The blue dot demonstrates the founder (most ancestral genotype) and yellow dots refer to sub-

group (secondary) founders. Each black dot represents single genotype (Kamthan et al. 2018).  

 

  

 

 

 

 

 

 

Limitations of MLST 
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Although MLST is an effective and widely applicable scheme for examining B. pseudomallei strain 

relatedness and epidemiological surveillance, there are several limitations associated with its use. 

The scheme is incapable of determining minor variations amongst closely related isolates. MLST is 

not suitable to characterize small differences in strains from a potential point-source outbreak. 

Moreover, MLST can also take several days to weeks to obtain results, and is therefore unable to 

quickly distinguish the occurrence of an outbreak (Currie et al. 2007). In the event of a potential 

outbreak or case cluster of melioidosis, rapid and highly discriminatory fingerprinting methods, such 

as multiple-locus VNTR analysis (MLVA) or BOX-PCR, could be used to show how closely related 

isolates are. MLST may then be used for sequence typing and examining isolate divergence.  

 

Methods for Rapid Strain Typing of B. pseudomallei 

1. MLVA-4 

PCR-based variable-number tandem repeat (VNTR) loci is a widely utilized tool used for rapid 

strain typing of pathogens (Currie et al. 2009; Van Belkum 2007). Multiple-locus VNTR analysis 

(MLVA) is comprised of several tandemly repeated sequences of DNA that vary in copy number, 

producing different PCR-amplicons that can be visualised on a gel. MLVA allows for superior 

discrimination between closely related isolates (Liu et al. 2006; Van Belkum 2007). A 4-locus 

MLVA platform has more recently been developed for B. pseudomallei. This rapid and highly 

discriminatory typing tool can produce results within eight hours of receiving 

B. pseudomallei isolates. It has also been used on multiple occasions to identify point-source 

outbreaks of melioidosis (Currie et al. 2009). 
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Figure 102- The MLVA process typically involves the detection of variable-number tandem repeats 

(VNTR) using PCR. Different sized products are used to determine how closely related bacterial 

strains are to one another (CDC 2016).  

 

2. BOX-PCR  

BOX-PCR was conceived as a simple and rapid tool to discriminate between B. pseudomallei 

isolates. It was initially adapted from methods used to differentiate Burkholderia cenocepacia 

isolates in cystic fibrosis patients but has since been demonstrated to be equally discriminatory 

in B. pseudomallei (Coenye et al. 2002; Currie et al. 2007). BOX-PCR can provide results within 10 

hours of receipt of bacterial isolates, meaning it is a valuable tool for rapidly determining the 

relatedness of isolates during a possible outbreak scenario.   

 

https://www.ncbi.nlm.nih.gov/pmc/articles/PMC1925088/figure/F3/
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC1925088/figure/F3/
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B. pseudomallei MLVA-4 Protocol 

The following protocol was provided by Menzies School of Health Research, Darwin, Australia. It has 

been adapted from Currie et al. Emerg Infect Dis. 2009; 15 (2):169-74. Contact 

mark.mayo@menzies.edu.au for further questions concerning the protocols described here. 

 

NOTE- The protocols for MLVA-4 typing require specific data analysis software and thorough 

training of laboratory staff. This may make the technique impractical for many laboratories. In this 

instance, labs can also conduct BOX-PCR typing for rapid B. pseudomallei strain comparison (see 

the protocol below), as this method requires fewer technical equipment and training. 

 

Technical Guides: 

• GeneMapper Software- 

http://tools.thermofisher.com/content/sfs/manuals/cms_042039.pdf  

• BioNumerics Software- 

 https://www.applied-maths.com/applications/mlva  

 

Primers:  

LOCUS 2341 1788 933 389 

Color-labeled 
forward primer 
sequence (5′ → 3′) 

FAMGGCTTCGCACCC
GCCCCATTTCAGC 

PETGCGCGGCGAGAAC
GGCAAGAACGAA 

NEDATGGTGGCGGCC
GTCGGCGAAAACC 

VICGTTACAAGCGCGGG
TCGGCAAGAGGCTGAA
A 

Reverse primer 
sequence (5′ → 3′) 

GCACCGGGCGCGGC
GCACTCG 

GAGCATCGGGTGGGCG
GCGCGTATTGAT 

GCTCGAATGGGTGTA
CGAAGGGCCACGCTG
ATTC 

GCCGGTGTTGAACGAG
TGGGTGGCGTAAGC 

Repeat sequence 
(5′ → 3′) 

TTCGTGCGC GTCGTGCGATCCTGCT CGGCGAGGGAAA GACGAACC 

Minimum size (bp†) 111 (2) 235 (4) 171 (3) 221 (1) 

Maximum size (bp) 243 (17) 382 (13) 337 (17) 292 (10) 

†Error range in fragment sizing is ± 3 bp. 
 
 
1. Create a list of isolates to be tested and set up a plate template 

mailto:mark.mayo@menzies.edu.au
http://tools.thermofisher.com/content/sfs/manuals/cms_042039.pdf
https://www.applied-maths.com/applications/mlva
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For each sample, 4 individual PCR reactions must be done (hence MLVA-4). 
A. Create a sample list with the sample names/IDs and a plate template to keep track of sample 

locations (see example below).  

B. Calculate the amount of master mix required based on the table below. Each reaction should 
contain 10µL of master mix and 1µL DNA template. Be sure to include a negative control, 
positive control and at least 2 additional samples to allow for reagents lost during pipetting. 

C. This will give the amount of master mix required for ONE SET OF PRIMERS.  For MLVA 4, 
there are four primer sets: 389, 933, 1788 and 2341. Four master mix mixes should be 
created for each set of samples. 

 
 

For Each MLVA Primer:       

  
Start 

Concentration 
Final 

Concentration. Volume per reaction (µL) 

PCR Buffer 10 X 1 X 1.1 

MgCl2 25 mM 3 mM 1.32 

dNTPs 2 mM 0.2 mM 1.1 

Betaine (Q 
solution) 5 M 1.2 M 2.64 
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Hot Star Taq 5 u/ul 0.08 u/ul 0.18 

Forward Primer  20 uM 0.2 uM 0.11 

Reverse Primer 20 uM 0.2 uM 0.11 

PCR Water        3.4 

DNA template     1 

Total     11 

 
2. Setting up the PCR 

A. Prepare the four master mixes in the PCR clean room. 
B. Ensure all surfaces and pipettes are cleaned before and after preparing the master mix with 

10% bleach or DNA decontaminant, followed by 70% ethanol. 
C. Take your master mixes to the DNA template addition area.  
D. Draw a line across the 96-well PCR plate between rows D and E. Aliquot 10µL of master mix 

across the PCR plate in rows A-D, and then again in rows E-H (as shown below). 
 

 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

E. Add 1L of the DNA control in column 1, only in rows A-D. 
F. Continue adding samples across the plate (1-12) in rows A-D. Sample 13 -24 will be in rows 

E-H. 
G. Seal PCR plate with strip cap covers or with PCR film (e.g. BIO-RAD Microseal ‘B’ film). If 

using film be sure to use a plate sealer/roller to completely seal and prevent evaporation 
during thermal cycling.  

H. Briefly centrifuge the plate to remove bubbles. 
 
3. Running the PCR 

A. The PCR thermal cycling conditions are as follows: 
 

Step Temp. (°C) Time 

1 94 5 minutes 

2  94 30 seconds 
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68 30 seconds 

72 30 seconds 

Cycle 34 times  

3 
72 5 minutes 

15 hold 

 
B. Briefly centrifuge the plate after the PCR has finished running. 

 
4. Running a gel to confirm PCR products  

A. Make up a 1% 200 mL agarose gel for every 12 samples tested (e.g., if you have 23+control 
(24 total) samples in a 96 well plate, you will need 2 x 200mL gels). 

B. Follow the instructions found in “Chapter 14- Convention PCR” covering how to prepare an 
agarose gel for electrophoresis. 

C. In the first well of each row in the gel, add 6 µL of 100bp marker. 
D. Mix 2 µL loading dye with 5 µL of PCR products from row A and add the gel. Repeat this for 

the first 12 samples in rows A-D of the PCR plate (As shown in the image above). 
E. Be sure to mark the running tank with “samples A-D”. 
F. With the second 200mL gel, repeat steps C-E using the DNA from rows E-H of the PCR plate. 
G. Run the gels at 100mV for ~30 minutes. It is important to keep checking the gel and where 

the dye front is. These are small PCR products; it is important make sure the products don’t 
run off the gel. 

H. Visualize the gel using a gel documentation system. 
I. Check that all 4 products have amplified for each sample.   

a. If there are no bands at all on the gel (i.e. only a marker), the PCR has failed – repeat 
the PCR reaction again. 

b. If you have bands in 3 of the regions for a sample but one hasn’t worked, repeat the 
PCR on the single region that has not work.  

c. If all 4 regions have failed (i.e. no bands) for a sample (but other samples are ok), the 
DNA extraction may not have worked for that sample and needs re-extraction. 

 
5. Pooling the PCR Products for each sample 

A. PCR products must be pooled together before being sent for DNA sequencing. 
B. Pool products in a 96-well round-bottom plate (such as a 2mL NUNC plate) or into sterile 

closable microcentrifuge tubes (e.g. 1.7 mL Eppendorf tubes) if there are only a few samples. 
C. Take 3.5uL from row A of the PCR products. Transfer to column A of the round-bottom plate 

where the products will be pooled (as shown in the image above).  
D. Take 3.5uL of row B, C and D of the PCR products. Transfer to column A of the round-bottom 

plate. All 4 amplified regions for each sample will now be pooled. 
E. Take 3.5uL each from Row E, F, G and H of the PCR products and transfer to column B of the 

round-bottom plate.  
F. Carefully document and label which samples are in which wells of the round-bottom plate or 

in which tubes they have been placed. 
 
6. Dilution of the pooled product 

A. To each of the pooled products add 500 µL of distilled H2O. Pipette up and down to ensure it 
is well mixed. 

B. The samples can now be sent to any commercial sequencing laboratory (e.g. Macrogen, 
Seoul, South Korea).  

 
7. Analyzing the sequencing results 
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A. Sequenced product sizes must now be analyzed. The following describes a protocol using 
“GeneMapper”, which is a genotyping software package that provides DNA sizing for all 
Applied Biosystems Genetic Analyzers. 

B. Go to File→ New Project. Select “Microsatellite”. 
C. Go to File→ Add samples to project. 
D. Browse to find where the sample list created at the beginning of the procedure is stored. 
E. Select/highlight the sample files (.fsa files) and Press “Add to list”. Once you have all of your 

samples, Press “Add”. 

a.  
F. You now need to tell the program which analysis methods you wish to use. In the first cell of 

each column that needs changing, select the required method. Then click at the top of the 
column (to highlight the whole column). Then press CONTROL D to auto fill for all samples. 
Select the appropriate analysis method, panel and size standard (these will need to be 
manually set when running the protocol for the first time). 

G. The fragments are now ready to analyze: Click the Green Play button at the top of the 
screen. 

H. Review the panel of indicators. The panels should appear green if the protocol has worked. If 
there are any yellow triangles or stop signs, this needs to be checked. 

a. Usually a yellow triangle or stop sign indicates there is a problem with the size 
standard and the program has been unable to call the size properly. See below on 
how to fix a size standard.  

Fixing a size standard: 
a. Select the sample that is red or yellow. 
b. Click on the “Size Match Editor” icon. 
c. Look at the plot – are there smooth, well defined peaks there? Are all the numbers 

on the peaks correct? 
a. If there are no numbers, you will need to add in the numbers by clicking on 

the peak and then right clicking – Add – then select the number (use the 
chart to guide you on which peak represents the right number). Click 
“Apply” and “Override SQ”. 

b. If there are numbers, double check that they are in the right space. 
c. If there are no numbers and there are no nice peaks, the reaction has failed 

and will need to be repeated. 



ASM/CDC Melioidosis Manual - 2022 

332 
 

d. Once everything has been checked and all the samples display a green sign, proceed 
with the panel binning: 

 
8. Panel Binning 

A. Select the “Genotypes” tab. Check that all samples display the appropriately matching 
alleles. 

B. Edit→ Select All. 
C. Tools→ Panel Manager.  Press the “+” next to MLVA 4. Select the MLVA 4 tab that appears. 
D. Select→ “Apply” then “OK”. 
E. Go to Tools→ Table Editor settings.  Click on the “Genetypes” tab then select “OK”. 
F. Click the “Display Plots” Icon – (multi coloured peaks). 
G. You will now check all 4 markers for each isolate. 

a. If all 4 have a peak that falls in the grey areas (assigned “Bins”), they should have a 
box under the peak with the peak details.  

b. If the peak trace is messy, the reaction (PCR) will need to be repeated. 
H. Click File→ “Save Panel” then “Exit”. 
I. Click File→ “Export table”. The table should be saved as a .txt file for upload into 

BioNumerics Software. 
J. Ensure that all the raw data files and the GeneMapper files/exported table are saved in an 

appropriate folder. 
 
9. Preparing the GeneMapper export file for import into BioNumerics 

A. Open the GeneMapper export .txt file in the BioNumerics software. 
 

B. Select all (CTRL – A). 
C. Open an excel worksheet and paste (CTRL –V) the GeneMapper export table. 
D. Remove all columns except for:  

Sample Name Marker Dye Allele 1 Size 1 Height 1 
Peak Area 
1 Data Point 1 

 
E. Remove the letters from the Sample Name for all isolates. BioNumerics can only import 

sample names based off the “Key” identifier. This means you will need to change the Sample 
name of all samples to include only the # (e.g. MSHR1234 should become 1234).  

F. Assign the “MLVA number” (this number won’t be uploaded into BioNumerics but will be 
manually added later). 
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a. Open your saved document that contains information about the key and the “Bin” 
ranges.  

b. To determine the MLVA number, click on the “MLVA 4 type key” tab. Using the filter 
function in the spreadsheet, enter in the allele combinations given for each sample. 
A MLVA4 number for the sample will be given based on the combination.  

c. If the combination does not exist, add it to the end of the list and give it the next 
“MLVA number” in sequence. 

d. Write down this number separately as you will be manually adding this info in later. 
G. Now delete the allele columns from the spreadsheet. The file cannot be uploaded into 

BioNumerics with the allele column still present. 
H. The file should look like this: 

Sample File 
Name Marker Dye Size  Height  Peak Area  

Data 
Point  

4803 2341 B 188.61 375 4883 2780 

4803 389 G 235.6 548 6599 3576 

4803 933 Y 230.45 508 5660 3487 

4803 1788 R 364.47 200 5035 5853 

4943 2341 B 153.14 498 5883 2093 

4943 389 G 243.29 653 7794 3549 

4943 933 Y 361.04 292 3974 5542 

 
I. Open up a new Excel document. Copy the results for one sample into the document: 

Sample File 
Name Marker Dye Size  Height  Peak Area  

Data 
Point  

4803 2341 B 188.61 375 4883 2780 

4803 389 G 235.6 548 6599 3576 

4803 933 Y 230.45 508 5660 3487 

4803 1788 R 364.47 200 5035 5853 

J. Save the document as a tab delimited file with the sample name as the file name (i.e. 
MSHR4803.txt) 

K. Open up another new Excel document. Paste in the next sample (with the headings). Save 
the document as a tab delimited file with the sample name.  

L. Do this for every isolate (saving each isolate/sample as its own file. Be sure to include the 
heading for each file). This may seem unnecessary, but it is difficult to remove a result from 
BioNumerics if a mistake is made unless each sample has its own file. 

M. Open up the BioNumerics software. 
N. Import the GeneMapper trace/peak file: File→ Import→ Import GeneMapper Peak File. 

Sample 
Name Marker Dye Size  Height  Peak Area  

Data 
Point  

4943 2341 B 153.14 498 5883 2093 

4943 389 G 243.29 653 7794 3549 

4943 933 Y 361.04 292 3974 5542 

4943 1788 R 298.83 295 6824 4482 
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O. Select the tab delimited .txt file just created and open the file. 

P. The next screen should appear automatically. 
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Q. Leave the boxes as they are. Click OK. The file will now download. 
R. Repeat this for every sample you are uploading. 
S. Find the uploaded isolates by locating their “Key” numbers on the left-hand side of the page.  
T. Double click on the isolate. Enter the information you have about the isolate including the 

newly assigned MLVA4 number. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
U. Click “OK” when finished. 

 
To create a dendrogram: 

a. Hold down the “CTRL” key and select (using the mouse) the isolates you wish to use 
in the dendrogram. A small orange arrow will appear next to the selected isolates. 
The tree will need to be rooted using an appropriate B. pseudomallei isolate.  

b. Once all the isolates have been selected, click the “Comparisons” tab in the bottom 
right hand corner. 

c. Select the “Create new comparison” icon. 
d. The isolates will appear in a new window. 
e. On the left side of the screen, in the Experiments box, scroll down to the bottom to 

MLVA4. Click this experiment (a green tick should appear over the MLVA4 icon). 
f. Select the “Calculate cluster analysis” icon. 
g. Choose “Calculate cluster analysis – Pairwise similarities”. 
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h. Use the default settings: Average from experiments and UPGMA for the 
“dendrogram type”. Click OK.  

i. To print: Click print preview. 
j. Move the fields to suit what you wish to print. 

 
Uploading sample information into BioNumerics: 

A. Create a .txt file (start in excel and then save as .txt tab delimited file) that has the Sample 
names as the Key (e.g.MSHR4145 has a key of 4145) with the information in the following 
columns that you wish to import. 

Sample File Name MLVA-4 type 

4018 15 

4021 110 

4022 44 

4023 16 

4024 16 

4025 16 

4026 16 

4027 16 

4028 16 

 
B. In BioNumerics, open File→ Import→ Import fields and characters. 
C. Locate the .txt file to import via the browse function. Click OK. 
D. The wizard identifies the columns present in the file. You now need to link them to a field in 

BioNumerics. 
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E. Click on the first row. Make sure the “Field Type” function has “text” selected.  You now link 
it with “Key” by selecting it from the drop-down box list. 

F. Do the same for all other external fields until all are completed 
G. “Link control field” should be set to “Key” 
H. Click OK to upload. 
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Figure 102- Dendrogram showing MLVA-4 profiles for isolates from three patients with melioidosis, 

along with corresponding isolate numbers and multilocus sequence types (Currie et al. 2009).  

 
 

B. pseudomallei BOX-PCR Procedure (adapted from Currie et al. 2007) 

Primer: 

BOX-A1R: (5’-CTACGGCAAGGCGACGCTGACG-3’) 

A. PCR Set-Up 

1. Create a PCR plate template to keep track of where samples will be placed. 

2. Calculate the master mix volumes needed for the number of samples to be tested based on 

the table below. Remember to include 2 additional samples to account for reagent lost 

during pipetting.  
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 Reagent Concentration Volume per reaction (µL) 

10X PCR Buffer 1X 2.5 

MgCl2 (25mM) 4.5 mM 4.5 

dNTPs (2mM) 200µM 2.5 

Q or Betaine Solution 1X 5 

Hot Star Taq (QIAGEN) 5U 0.25 

BOX-A1R Primer (30µM) 1.05µM 0.875 

PCR Water   7.375 

DNA template  2 

Total  25 

 

3. Prepare the master mix in the PCR clean room/area. 

4. Gently mix the master mix then briefly spin in a microcentrifuge. 

5. Pipette 23 µL of the master mix into the appropriate well of a 96-well plate or PCR strips 

according to the plate template worksheet. 

6. Cover the wells using cap strip covers. Spray down the clean workspace with bleach or 

DNAerase and follow with 70% ethanol. Remove laboratory coat and gloves and put on a 

clean pair of gloves. Take the 96-well plate or PCR strips to the DNA template addition area. 

7. Put on a new laboratory coat, keeping the same pair of gloves on. Very carefully, take off the 

cap strip covers from the 96-well plate or PCR strips. Open these slowly to prevent 

aerosolization and spraying of any liquid in the wells.  

8. Add 2 µL of template DNA to each appropriate well of 96-well plate or PCR strip according to 

the plate template worksheet.  

9. Add 1 µL water to the ‘NTC’ well. 

10. Add 1 µL of the positive control DNA to the correct well.  

11. Cover the wells of each column of the PCR plate or each PCR strip using strip caps as you go 

and secure caps tightly. 

12. Wipe down the workbench area with bleach or DNAerase, followed by 70% ethanol. Remove 

laboratory coat and gloves. If possible, briefly spin the plate at 1000 rpm to remove any 
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droplets. Transport plate to the PCR thermocycler room/area and place it in the PCR 

thermocycler. 

13. Place tubes/plates in the conventional PCR machine. 

14. Set the following thermal cycling conditions and press start: 

 

 

 

 

 

 

B. Running the Gel 

1.  Make a 2% agarose gels for the required number of samples to be run (follow the 

procedures outlined in Chapter 14- Conventional PCR). 

2. Load the gel using a 100bp ladder and 2 µL DNA loading dye mixed with 10µL PCR product.  

3. Place the lid on the gel tank, plug electrodes into a power pack setting it to run at 100mV.  

4. Once ready lift gel from the tank and visualize results on Gel Doc machine. 

 

C. Results Interpretation 

BOX-PCR gel results should always be interpreted in the proper epidemiological context and the gels 

alone should not be used to confirm an epidemiological connection or outbreak. It is always 

important to confirm the link with another more robust typing method, such as MLST or whole-

genome sequencing (see below). The quality of the gel electrophoresis results and the variability and 

the prevalence of the pattern in question should always be considered. 

 

Only isolates displaying identical banding patterns should be considered as potentially being the 

same isolate/strain and the possible cause of an infection cluster, patient relapse, or point-source 

Stage Time Temperature # Cycles 

Initial denaturation 5min 95oC 1 

Amplification 

1min 95oC 

35 1min 40oC 

2min 72oC 

Final Extension 10min 72oC 1 

Hold -- 4oC -- 
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outbreak. If the samples in question display different BOX-PCR banding patterns they should be 

considered unique, unrelated isolates (e.g., not part of the same cluster or a patient reinfection 

rather than relapse). An example is shown in Figure 103 below. Here, BOX-PCR has been used to 

demonstrate that a melioidosis patient has been reinfected with a new strain of B. pseudomallei and 

is unlikely to have had a relapse in their primary infection, as two distinct banding patterns are 

present. 

 

 

Figure 103- The BOX-PCR banding 

patterns in lanes 6-10 of the gel, which 

are isolates cultured from the patient’s 

initial infection, have a unique banding 

pattern and are different than isolates 

cultured from the same patient’s 

subsequent infection nearly one year 

later. This likely indicates that the patient 

was infected by a different strain of the 

bacteria and has not been reinfected by 

the same strain (e.g. from a single point-

source) or have had a relapse in infection 

due to inadequate treatment (image 

courtesy of Menzies School of Health 

Research, Darwin Australia). 

 

MLVA-4 and BOX-PCR Limitations 
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While both BOX-PCR and MLVA-4 have proved useful for smaller regional surveys of B. pseudomallei, 

a serious hindrance to their widespread practical application thus far has been the difficulty involved 

in data sharing, limiting inter-laboratory isolate evaluation (Cheng et al. 2005). These rapid strain 

typing methods can lack reproducibility and robustness and variations in results have been shown to 

occur between different labs or PCR machines (Currie et al. 2007). MLVA also requires trained and 

skilled laboratory technicians. It is recommended that these schemes be used in conjunction with a 

more robust and reproducible typing method, such as MLST, to confirm the event of an outbreak or 

case cluster and to verify the relatedness or divergence of strains.  

 

Next Generation Sequencing for Bacterial Strain Typing  

The arrival of the first high-throughput, rapid next-generation sequencing (NGS) technology has 

signalled an important shift in microbial genetics research. Since then, sequencing platforms have 

become more advanced in their data quality, cost, and accessibility, with whole-genome 

sequencing (WGS) platforms providing a comprehensive method for analyzing entire bacterial 

genomes (Edwards & Holt 2013; Köser et al. 2012). In addition to providing a much wealthier 

source of genetic information, WGS now also supersedes many genotyping methods in pricing. For 

example, WGS now costs less to carry out than conventional Sanger sequencing-based MLST.  

 

Current WGS platforms are comparatively fast and can be generated in-house in some laboratories. 

Much of the data generated is also available through online public databases, including the National 

Center for Biotechnology Information (NCBI) GenBank (https://www.ncbi.nlm.nih.gov/genbank/), 

allowing for extensive comparative analysis (Edwards & Holt 2013). The high-resolution data 

generated from WGS can be utilized to investigate various aspects of B. pseudomallei genetics, 

including the spread of drug resistance (Webb et al. 2017), within-host evolution (Price et al. 2010; 

Köser et al. 2012), as well as outbreak source attribution through the examination of isolate 

genome-content variability (McRobb et al. 2015; Sarovich, D. S. et al. 2017). Moreover, WGS has the 
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ability to extract MLST sequence types directly from reads, permitting a highly precise method of 

MLST typing of B. pseudomallei (Edwards & Holt 2013; Lam et al. 2012). The Bacterial Isolate 

Genome Sequence database (Jolley & Maiden 2010) now allows for the PubMLST website to use all 

levels of sequence data, including complete, finished genomes. Where resources permit, WGS and 

in silico MLST could be used after rapid fingerprinting of isolates to confirm an outbreak or case 

cluster and to further examine the relatedness of strains. 

 

B. pseudomallei WGS Data Analysis 

When applying WGS to study the molecular epidemiology of bacterial pathogens such as B. 

pseudomallei, it is useful to examine variations in a genetic sequence, or set of sequences (Schürch 

et al. 2018). Genome variants can take several forms, including nucleotide insertions, when 

additional nucleotides are found in a sequence, nucleotide deletions within a sequence, or a single 

base change, referred to as a single nucleotide polymorphism (SNP) (Schürch et al. 2018). These 

variations can arise through point mutations, homologous recombination or discrepancies in 

genome content (Bryant et al. 2012). Most studies rely on SNP data for population and 

epidemiological analysis since variability between bacterial strains can be translated into measures 

of distance in core genome alignments, or can be indexed to assign unique allelic profiles (Schürch et 

al. 2018). Additionally, SNPs can be found even in regions of high homology, or regions of shared 

ancestry not recently affected by recombination, and thus can more accurately reflect evolutionary 

time (Pearson et al. 2009). SNPs are also more informative than other currently used molecular 

markers due to intrinsically slow mutation rates and extensive distribution across the entire genome. 

Large numbers of shared SNP loci can thus facilitate robust characterization amongst closely related 

isolates (Pearson et al. 2009).  



ASM/CDC Melioidosis Manual - 2022 

344 
 

 

Figure 104- Whole-genome sequencing data from a melioidosis outbreak in the Darwin region of 

northern Australia. Here, a phylogenetic tree was constructed using combined SNP and indel data 

from B. pseudomallei environmental and clinical isolates to demonstrate that the source of a 

melioidosis outbreak was from a contaminated domestic water supply (McRobb et al. 2015). 

 

Identification of insertions, deletions, or SNPs begins with mapping and aligning sequence reads to a 

closely related reference genome (Li & Homer 2010). Variant determining algorithms have quality 

filters that then attempt to define variants, versus sequencing errors. Alignments are normally 

performed using a microbial SNP pipeline, such as Snippy, NASP, or SPANDx (Sahl et al. 2016; 

Sarovich & Price 2014; Schürch et al. 2018). The resulting alignment can then be used for 

phylogenetic analysis. To increase resolution, genomes chosen for the reconstructed phylogeny are 

normally closely related to one another. This allows for discrimination between isolates that differ 

by only a few SNPs, which is especially important in facilitating investigations into outbreak source 

attribution (Pearson et al. 2009).  
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Figure 105- Whole-genome sequencing normally consists of DNA extraction, shearing the extracted 

DNA into small fragments, creating a “DNA library” that includes many copies of each DNA fragment. 

Each fragment is then sequenced to create a read, and finally, analysis of the sequenced products 

occurs (CDC 2013). 

 

Most commercial sequencing laboratories now offer fast, well-priced WGS sequencing facilities. 

However, due to the complexity of WGS and the extensive bioinformatics training required to 

properly analyze and interpret WGS data, it is best to contact a diagnostic reference laboratory or 

research laboratory with WGS capabilities and expertise if considering implementing the 

technique for the first time.  

 

Chapter Summary 
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The preceding chapter presents an overview of bacterial molecular characterization and several 

common methods used for B. pseudomallei strain typing. Bacterial strain typing is important for 

disease diagnosis, treatment, and epidemiological surveillance, particularly for highly pathogenic 

species such as B. pseudomallei. Potential outbreaks of melioidosis warrant rapid public health 

response and high-resolution molecular typing tools, such as those described above, are needed to 

quickly investigate the infection etiology.   
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Chapter 17: B. pseudomallei Suspected Isolate Reporting, Storage and 

Data Management  
 

Chapter Overview 

While melioidosis is not a notifiable disease in all countries, it is recommended that suspected cases 

be reported to local or national sentinel laboratories that can assist with diagnostic confirmation, 

epidemiological investigation, and provide important biosafety guidance. The U.S. Centers for 

Disease Control (CDC) and U.S. Department of Agriculture (USDA) have identified biological agents 

and toxins that they consider to be a threat to public health because of their potential use as 

bioterrorism agents. These are referred to as “select agents”. Their transfer, possession, use, and 

disposal are strictly regulated in the United States. B. pseudomallei is classified as Tier 1 select agent 

(https://www.selectagents.gov) and its identification should be reported to a Laboratory Response 

Network (LRN) laboratory or sentinel laboratory as soon as possible upon identification. The 

following chapter describes the appropriate protocols for reporting and transporting B. pseudomallei 

to reference laboratories.  

 

Reporting a Suspected or Confirmed B. pseudomallei Isolate  

Any oxidase-positive, indole-negative, gram-negative rod that is resistant to gentamicin and colistin 

but sensitive to amoxicillin/clavulanic acid should be suspected as B. pseudomallei until this 

identification is ruled out (Trinh et al. 2018). For suspected or confirmed cases, clinical laboratories 

should refer to local and national disease authorities and comply with the specific reporting 

requirements. This typically involves reporting cases and laboratory results and may also mean that 

the isolate concerned is subject to specific biosafety and biosecurity measures. Laboratories that 

typically perform bacterial work on an open bench should transfer all suspected cultures to a class II 

BSC or higher where possible, especially when performing potentially aerosol-generating 

https://www.selectagents.gov/
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procedures. See Chapter 4 for further detail regarding B. pseudomallei biosafety (ASM 2016; BMBL 

6th ed. 2020; Peacock et al. 2008).  

 

Although the risk of laboratory acquired infection with B. pseudomallei is relatively low compared 

with some other bacterial select agents, clinical laboratories should perform a risk assessment and 

develop protocols to prevent accidental exposure. This includes strictly enforcing standard 

laboratory procedures and GLP, conducting culture work for suspected isolates inside of a BSC, and 

wearing appropriate personal protective equipment (PPE), as described in Chapter 4 (BMBL 6th ed. 

2020). If an accidental exposure occurs, the risk of exposure should be determined based on the 

guidelines described in Chapter 4 (APHL 2017; Peacock et al. 2008).  

 

Data Management and Record Keeping 

A data management system should be used to keep track of specimens and isolates processed by 

the clinical laboratory and those that are being stored long-term. A computerized record keeping 

system is recommended, but handwritten laboratory logbooks may be used where these are 

unavailable. Small or resource-poor laboratories may find that paper records are sufficient. 

However, computerized methods are recommended for laboratories that handle larger quantities of 

clinical specimens and isolates. Commercial laboratory information management systems (LIMS), 

such as Freezerworks, may also be used where resources permit. 

 

Regardless of whether the data management and recordkeeping system is computerized or paper-

based, all data must be accurately and reliably recorded and easily accessed. Human errors in record 

keeping are very common and great care should be taken to avoid errors. It is best to use a single 

unique specimen or isolate reference along with at least two other data items such as patient name, 

date of birth or hospital number.  Bar code printers and scanners reduce the risk of human 
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transcription errors. It is also critical that laboratory data is linked with epidemiological data to 

ensure the accuracy. 

 

It is recommended that individual laboratories maintain several records, including: 

• Detailed records of every isolate. 

• Secured access to isolates. 

• Safety, security, and emergency response plans. 

• Training records. 

• Reference lab transfer forms (if used): The designated reference laboratory should advise on 

any required transfer forms. Always ensure the latest versions of these forms are being 

used. 

• Safety and security incident reports. 

 

Storage of Isolates 

If isolates need to be sent to a reference laboratory for confirmation or further testing, they should 

be stored appropriately to ensure viability. Isolates should always be confirmed as pure cultures 

before they are stored. Fresh cultures (e.g., ~48 hours growth) should always be used when storing 

isolates. Aseptic techniques should be used when preparing isolates for storage to prevent 

contamination. 

 

Short-term storage of B. pseudomallei can be carried out on agar slants/slopes (e.g. on tryptone soya 

agar slants) or in other liquid broth medium containing glycerol for 1-2 weeks. Instructions for 

preparation of agar slants and glycerol broth are described below. Slants can be produced as a 4 mL 

slant in a 7 mL screw-cap tube or 1 mL slant in a 2 mL screw-cap tube. They should be stored at 4°C 

until transporting. Broth should be frozen at -20°C (or -70°C for longer-term storage). 
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Tryptone Soya Agar Slope Protocol 

1. Weigh out 15 grams of TSB powder (Tryptone Soya Broth – Oxoid CM0131 or locally 

available equivalent). 

2. Put the TSB powder in a 1 L autoclavable glass beaker or flask containing a magnetic stirrer 

on top of a magnetic hot plate. 

3. Add 500 mL of distilled water to the bottle and turn the stirrer on.   

4. Allow the solution to mix thoroughly until all the powder is dissolved. 

5. Add 5 grams of Bacteriological Agarose and stir for 5 minutes. 

6. Autoclave for 30 minutes at 121°C or sterilize in a pressure cooker if an autoclave is not 

available. 

7. Take the bottles out of the autoclave/pressure cooker once finished and allow to cool 

slightly (until the agar is at ~60°C). 

8. Make 1 mL aliquots of the agar into 2 mL screw-cap tubes, or 4 mL slants in 7 mL screw-cap 

tubes. If the agar starts to solidify before finishing, sit the bottle in the water bath set at 60°C 

for 5 minutes and continue once it is liquid again. 

 

Tryptone Soya Broth Containing 15% Glycerol  

1. Weigh out 30 grams of TSB powder. 

2. Add the TSB powder to a large 2 L glass beaker or flask containing a magnetic stirrer on top 

of a magnetic hot plate. 

3. Add 850 mL of distilled water to the beaker and turn the stir plate on.   

4. Allow to mix until all the powder is dissolved. 

5. Add 150 mL of glycerol and stir for a further 5 minutes (or until all glycerol is mixed). 

6. Divide the broth into 2 x 500mL glass bottles.  

7. Autoclave for 30 minutes at 121°C or sterilize in a pressure cooker if an autoclave is not 

available. 
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8. Take the bottles out of the autoclave/pressure cooker once finished and allow to cool. 

9. Once cool, aliquot 1 mL in to 2 mL screw cap tubes. Store at 4°C until needed.   

 

Isolate Shipping and Transfer  

Upon notification to the local health department of suspected B. pseudomallei, laboratories should 

be prepared to appropriately package and ship specimens or isolates. See the packaging and 

shipping section in Chapter 6 for additional information about appropriate packaging and shipping 

procedures. 

 

Transport of diagnostic specimens and infectious substances should be done so that it minimizes any 

potential risks and also protects the viability of the isolate or specimen. The shipment of infectious 

substances or diagnostic specimens by air should comply with local, national, and international 

guidelines. International air transport regulations may be found in the IATA publication Dangerous 

Goods Regulations. https://www.iata.org/en/publications/dgr/. See Chapter 6 for more detail.  

 

Agar slopes/slants in screw-cap tubes can be shipped at room temperature (25°C) (IATA 2019; WHO 

2020).  

 

B. pseudomallei Isolate Security, Destruction and Decontamination  

If suspected specimens and/or isolate cultures are to be transferred to a reference laboratory, they 

should be transported within 7 days of confirmed identification where possible. During this time, 

specimens and isolates should be secured against theft, loss, or release until they have been 

transferred. If a laboratory is unable to transfer isolates or store them appropriately long-term at -

70°C, isolates should be inactivated or destroyed. Suspected or known loss of a specimen or 

associated materials must be reported immediately. Individuals not associated with the diagnostic 

laboratory should not have access to specimens or isolates and should be secured in locked cabinets, 

https://www.iata.org/en/publications/dgr/
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rooms, or other containers. Rooms should also be secure against entry by unauthorized personnel 

(ASM 2016). 

 

If a lab decides to transfer any specimens or cultures, staff should contact the local reference 

laboratory and work to ensure that the correct paperwork and protocols are followed. Copies of 

sample destruction logs, and documented reports should be maintained.  

 

If a laboratory chooses to destroy any specimens or isolates, it is also critical that these are properly 

inactivated prior to disposal. Isolates should not be directly discarded into the biohazardous waste 

stream like other infectious medical waste materials. Inactivation using an autoclave/pressure-

cooker or chemical decontamination should be done before disposal. 

 

Chemical Decontamination Process (APHL 2016) 

1. Prepare a fresh 1:10 bleach solution in any receptacle large enough to submerge all 

containers and plates suspected to contain B. pseudomallei.  

2. Working inside of a BSC, place culture containers in the bleach solution so they are fully 

submerged and leave in the bleach solution. This should be done overnight.  

3. Once overnight inactivation has occurred, discard the bleach solution down the drain with 

tap water running.  

4. Package all inactivated culture plates and containers with other biohazardous waste for final 

treatment and disposal.  

 

Checklist of appropriate steps to take if B. pseudomallei is to be transferred to a local or national 

reference laboratory for confirmation or storage: 
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____ 1. Contact the laboratory where the specimen/isolate will be transferred. 

____ 2. Package the suspected isolate(s) and other clinical specimens (aspirates, biopsies, sputum 

specimens) according to local and national regulations and send to laboratory. 

____ 3. Note who performed worked on cultures and if work was done inside of a BSC. Write down 

if any additional clinicians were involved in specimen collection (Peacock et al. 2018). 

____4. Notify public health authorities such as the local health department epidemiologist or health 

officer as required by the local or national disease reporting regulations.  

____5. Notify the infection control/disease team so the patient can be given appropriate treatment 

and an epidemiological investigation can be done. 

____6. Discuss with the laboratory about whether any further specimens should be submitted for 

testing. 

_____7. If Burkholderia pseudomallei is ruled out, continue with identification using local protocols. 

         

 

In countries where cases of melioidosis have not previously been reported or where there are no 

regulatory authorities in place to report cases, the website www.melioidosis.info also offers 

methods to report culture-confirmed cases of melioidosis, provides support for Burkholderia species 

http://www.melioidosis.info/
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identification, submitting unusual isolates, and advice or training on biosafety techniques. It can also 

help a laboratory to locate nearby Biosafety level 3 facilities to store B. pseudomallei clinical isolates. 

Contributors can be found on the main webpage map (https://www.melioidosis.info/map.aspx- red 

box).  

 

Laboratories are also able to report cases by clicking on “Report cases” on the primary tab on the 

website (shown below- red box). If the email application does not open, please copy the form, fill 

out the requested information and email it to melioidosis.info@tropmedres.ac.  

 

 

Chapter Summary 

B. pseudomallei is classified as a Tier 1 select agent by the U.S. CDC because of its high virulence and 

potential use as a bioterrorist weapon. Accordingly, many countries strictly regulate the transfer, 

possession, use, and disposal of B. pseudomallei isolates and contaminated specimens. The 

preceding chapter describes the appropriate protocols for reporting, transporting and documenting 

suspected B. pseudomallei isolates or specimens. While melioidosis is not a notifiable disease in all 

countries, it is recommended that suspected cases be reported to local or national sentinel 

laboratories or public health authorities who can assist with diagnostic confirmation and provide 

https://www.melioidosis.info/map.aspx-
mailto:melioidosis.info@tropmedres.ac
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biosafety guidance. The website www.melioidosis.info also offers methods to report culture-

confirmed cases of melioidosis, provides support for Burkholderia species identification and advice 

or training on biosafety techniques. 

 

 

 
 

 

 

  

http://www.melioidosis.info/
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Chapter 18: Melioidosis Surveillance and Filing a Clinical Case Report 

Form 
 

Chapter Overview and Introduction to Disease Surveillance 

Surveillance encompasses the collection, classification, analysis, interpretation, and reporting of 

health-associated data that enables public health decision making and action. Disease surveillance is 

accomplished through the ongiong collection, evaluation and dissemination of morbidity, mortality, 

and health data. Effective surveillance is essential to any prevention and control program and for 

effective public health decision making (CDC 2012).  

 

 

 

 

 

 

 

 

 

 

Figure 106- Surveillance starts with local healthcare providers like clinicians, laboratories, and 

hospitals and health departments. Feedback is provided by health departments back to local public 

and healthcare providers (CDC 2012). 

 

Regulations often exist for reporting certain diseases. These diseases are usually of high epidemic 

potential or with high morbidity or mortality rates and are known as “notifiable” diseases. Due to 

the high morbidity and associated case fatality rates, melioidosis is included on several national 
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notifiable diseases lists, particularly in endemic regions of the world including Thailand and Australia 

(Hinjoy et al. 2018).  

 

A case of melioidosis in a human should result in a report and investigation where possible. As the 

disease is rare or not well known in many countries, continuing education programs for healthcare 

workers and laboratory staff should include information on recognition and appropriate diagnostic 

tools and techniques. Certain at-risk populations, such as diabetics and those with underlying 

immunosuppressive conditions, may warrant more proactive surveillance, especially during periods 

of heavy rainfall or other adverse weather events (Suputtamongkol et al. 1999).  

 

Surveillance Levels and Feedback 

Infectious disease surveillance is conducted across multiple levels of government, enabling 

integrated and enhanced monitoring and feedback. Within a country, these levels can be broken 

down into: 1) local (e.g. clinician, hospital, laboratory), 2) intermediate (e.g. city, district, county, 

state), and 3) central/national surveillance (WHO 1999; WHO 2008). 

 

1. Local Level Surveillance  

The first effort to identify cases is normally focused at the local level (e.g., healthcare practitioners, 

clinics, hospitals, and laboratories) where an initial diagnosis is likely to be made. The primary 

responsibilities at this level include diagnosis and case management, reporting of cases and case and 

outbreak investigation (where resources permit). This is also the point at which surveillance data 

should first be collected and simple tabulation and graphing of data is performed (WHO 2008).  

 

Local healthcare staff should complete a case-report form on every suspected or confirmed case of 

melioidosis (see an example case report in Figure 107 below). The form may be completed by a local 

healthcare professional or by health authorities at the local level. This should be done to establish 
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any possible sources of infection, including recreational or occupational hazards that may have led 

to exposure to contaminated soil or water.  

 

Healthcare staff may develop a data collection form tailored to the specific details of that disease or 

a specific outbreak cluster. They may also use a generic case report form. Regardless of the case 

form that is used, it should include the following information (CDC 2012): 

a. Identifying information- The patient’s name, address, and telephone number are important 

in case physicians or investigators need to contact them for additional questions and to 

notify them of laboratory results. This information also helps to verigy if there are any 

duplicate records, while addresses allow the dispersal of infections to be mapped and 

visualized.  

b. Demographic information- Information such as age, sex, race, occupation, etc. will help to 

characterize the populations at risk in that area (e.g., rice farmer, construction worker). 

c. Clinical information- Clinical data will allow health investigators to establish whether the 

case definition for melioidosis has been met. Date of symptom onset is needed to chart the 

time course of the disease and possible time of exposure. Additional information, including 

length of illness, hospitalization or death, will help aid in the characterization of the 

infection. 

d. Risk factor information- This information should be specifically tailored to melioidosis. For 

example, determining whether the patient is diabetic or has an immunosuppressive 

condition, or has had any recent notable exposure to soil or water. 

e. Reporter information- The case report should include the name or information about 

reporter (typically a physician, clinic, hospital, or laboratory). Investigators will sometimes 

need to contact this individual for additional clinical information or to feedback any results. 
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Melioidosis Clinical Case Report Form 

Patient ID: 
 

__________________________ 

  

Date of Birth (DoB): ___ / ___ / ______ 

 (mm / dd / yyyy) 

Name: ___________________________ 

 (given)            (surname) 

 

Residential Address: 

 

Contact Phone #: 

 

Gender: 

 

 

______________________________________________________________________ 

 

_______________________ 

 

M / F 

 

Race: 

1 = White   2 = Asian   3 = Black or African American 

4 = American Indian or Alaska Native  

5 = Native Hawaiian or Other Pacific Islander 6 = Other 

 

Occupation:              

 

___________________________________________________________________ 

Recent Travel 

History: 

 

___________________________________________________________________ 

 

 

Risk Factors 

Diabetic:  Y / N Smoking:  Y / N 
Excessive 

Alcohol Use: 
 Y / N Renal Disease:  Y / N 

Chronic Lung Dis:  Y / N Occ. Exp:  Y / N 
Recreational 

Exposure: 
 Y / N 

Inoculation 

Event: 
 Y / N 

Malignancy:   Y / N Immunosuppression:  Y / N 
Cystic 

Fibrosis: 
 Y / N Oral Steroid  Y / N 

  Other: ________ ______________    

 

Admission No:  __ Diagnosis Date Discharge Date 

Date:  ___ / ___ / ______ ___ / ___ / ______ ___ / ___ / ______ 

 

Blood 

culture: 
 0 = -ve Died:  0 = no 

  1 = +ve   1 = yes- initial illness 

  2 = not done  

 2 = yes- relapse 

 

    

 3 = yes- unrelated 

 

  Date:   ___ / ___ / ______ 

    

 

 

 Treatment 
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Septic shock: Y / N 
 ICU admission:  Y / N  Inotropes:   Y / N 

  Ventilated:  Y / N  Renal Replacement Therapy:  Y / N 

 

Diagnoses: 1=Primary, 2=Secondary 

__   pneumonia __   genito/urinary __   bacteremic no focus 

__   skin abscess(es) __   soft tissue abscess(es) __   CNS 

__   osteomyelitis  __   septic arthritis __   other clinical focus 

 

  Chest XRay 

Abscesses    Coding 

  Left Right  1 = consolidation lobar 

Prostate: Y / N Spleen: Y / N  Upper:  __ Upper:  __  2 = other discrete cons. 

Liver: Y / N Kidney: Y / N  Lingula:  __ Middle:  __  3 = extensive patchy 

Other: ________ ___________ ___________  Lower:  __ Lower:  __  4 = patchy localised 

 

Treatment Antibiotic Dose Duration Compliance 

      Intensive 1     

      Intensive 2     

    Eradication 1     

    Eradication 2     

 

Blood 

WCC:  _ _ _ _ Neutrophil:  _ _ _ Lymphocytes:  _ _ _ _ Sodium:  _ _ _ _ 

Potassium:  _ _ _ _ CO2:  _ _ _ Urea:  _ _ _ _ Creatinine:  _ _ _ _ 

ALT:  _ _ _ _ Bilirubin:  _ _ _ GGT:  _ _ _ _ Protein:  _ _ _ _ 

  Albumin:  _ _ _ Platelets:  _ _ _ _  CRP:  _ _ _ _  

HbA1c (closest to admission) _ _ _  Date __/__/__ 

 

Serology: Indirect Hemagglutination Assay (IHA) 

Date Titer Date Titer Date Titer Coding 

__ / __ / __  __ / __ / __  __ / __ / __    1 = <1/20,    2 = 1/20, 

__ / __ / __  __ / __ / __  __ / __ / __    3 = 1/40,     4 = 1/80, 

__ / __ / __  __ / __ / __  __ / __ / __    5 = 1/160,    6 = 1/320, 

__ / __ / __  __ / __ / __  __ / __ / __    7 = 1/640,    8 = 1/1280, 

__ / __ / __  __ / __ / __  __ / __ / __    9 = >1/1280, 10 = not done 

 

 

Figure 107- Example of a patient case report form that may be used if a case of melioidosis infection 

is suspected or confirmed in an individual. The form is adapted from Menzies School of Health 

Research and Royal Darwin Hospital, Darwin, Australia and can be tailored based on individual data 

and epidemiological reporting requirements. 
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If there is any apparent temporal and/or geographical clustering of melioidosis cases based on the 

data collected, additional investigations may need to be occur. These can include: 

a. Collecting related soil and/or water samples for the detection of B. pseudomallei in the 

environment.   

b. Investigating the genetic relatedness of isolates using molecular methods where resources 

allow. 

c. Notifying local clinicians and residents about the cluster and about preventative measures 

that can be taken (e.g., chlorination or UV sterilization of domestic water supplies).  

 

Local health authorities are normally expected to gather primary data and organize initial 

epidemiological investigations targeted at identifying and controlling the source of infection 

(including identification and investigation of additional cases and tracing possible sources of 

infection) as well as initiating control measures. They are also responsible for reporting to the 

intermediate level (e.g. state) or to the central/national level (e.g. federal), depending on the 

government structure (WHO 1999).  

 

2. Intermediate Level Surveillance  

Depending on the political structure of a country, data from local surveillance and local case 

reports may be managed at an intermediate level, such as a state health department. The 

intermediate level often collates and analyzes data from local levels to examine epidemiological 

links and trends. The intermediate level may also help with epidemiological investigations and 

monitoring of control measures and typically reports data to the central/national level.  

 



ASM/CDC Melioidosis Manual - 2022 

362 
 

 

 

 

 

 

 

 

 

 

Figure 108- Surveillance of melioidosis cases; monthly rainfall vs. the number of melioidosis cases 

during a 12-year period in the Northern Territory, Australia. Here, the data is used to show that 

rainfall is associated with an increase of melioidosis cases (Currie & Jacups 2003). 

 

3. Central/National Level Surveillance 

Cases of melioidosis cases should be reported to the central/national level. This level will typically 

analyze and report data back to intermediate and local levels, devise national policies and allot 

resources based on the reported data. The central level may also offer practical and technical 

support to intermediate and/or local level laboratory or epidemiological staff and report summary 

surveillance data to international health authorities (WHO 2008). 
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Figure 109- Conceptual framework for public health surveillance. Effective surveillance requires 

continuous collection, analysis, interpretation, and distribution of results so that effective action can 

be taken (Porta 2008). 

 

Chapter Summary 

Effective surveillance is essential to any disease prevention and control program. It is accomplished 

through the collection, analysis, and interpretation of case reports and associated health data, and 

the dissemination of data to those involved in disease control and public health decision making. A 

single case of melioidosis in a human should always result in a patient case report and investigation 

where possible. This information should be communicated to intermediate and central levels of 

surveillance, enabling integrated and enhanced monitoring and feedback of melioidosis infection.  
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Glossary  
 

Aerobic bacteria- Bacteria that utilize oxygen for growth and oxygen-based metabolism. 

Agglutinate- the formation of clumps of cells or particles by specific antibodies to surface antigenic 

components. 

Algorithm- A procedure or formula for solving a problem, based on conducting a sequence of specified actions. 

Aliquot- To divide a portion of the whole, especially one of two or more samples of something that have the 

same volume or weight. 

Ashdown media- A selective culture medium for the isolation and characterization of Burkholderia 

pseudomallei. 

Augur- A drilling device used for making holes in wood or in the ground that typically has a rotating blade. The 

rotation of the blade causes the material to move out of the hole being drilled. 

Autoclave- A machine that uses steam under pressure to kill harmful bacteria, viruses, fungi, and spores.   

Broth microdilution- A method used to test the susceptibility of microorganisms to antibiotics where wells are 

filled with broth containing different concentrations of the antibiotic. 

Chaotropic- a substance that disrupts the structure and denatures molecules such as proteins and nucleic 

acids (e.g. DNA and RNA). 

Chelating- A chemical compound that binds tightly to metal ions. 

Electrophoresis- A laboratory method used to separate DNA, RNA, or protein based on size and electrical 

charge. An electric current is used to separate molecules through a gel. 

Eluate- A solution that is available for analysis after an elution is performed. 

Elution- A process in which particles are separated and extracted based upon size, shape and density by 

washing in a solvent (liquid substance capable of dissolving other substances). 

Endemic- Natural to, native, confined to, or widespread within a place or population of people. 

Enrichment broth- A liquid medium that contains different nutrients and is used to culture bacteria and other 

microorganisms. 

Exonuclease- Enzymes that work to remove nucleotides from linear single-stranded DNA in the 3' to 5' 

direction. 

Fluorophore- A fluorescent chemical compound that is able to re-emit light when energy is applied. 

Geographic Information System (GIS)- A system designed to capture, store, analyze, and display geographical 

data that can be referenced to locations on the earth. 

Gold standard- Something that serves as a reference that others can be measured or judged against. 

Gram-positive- Bacteria that have a thick peptidoglycan layer, no outer lipid membrane and retain the color of 

the crystal violet stain in the Gram stain. 

Gram-negative- Bacteria that have a cell wall composed of a thin layer of peptidoglycan and have an outer 

lipid membrane. The structure of their cell wall is unable to retain the crystal violet stain so they are colored by 

the counterstain. 
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Hemolysis- The rupturing or breakdown of red blood cells that leads to the release of their contents into the 

surrounding fluid.  

Heterogeneous- Populations, samples or results that are different or mixed. 

Homogenize- To blend different elements into a mixture that is the same throughout. 

Inoculate- A process where a small streaking loop is dipped into a solution containing bacterial cells and is 

used to streak an agar plate with the bacteria. 

Inoculum- A small amount of material containing bacteria, viruses, or other microorganisms that is used to 

start a culture. 

Intercalating- A substance that inserts itself into the DNA structure of a cell and binds to the DNA. 

Latent infection- An infection that typically does not cause noticeable symptoms and can last long periods of 

time without becoming active and causing symptoms. 

Latex agglutination- A laboratory test used to check for specific antibodies or antigens in different body fluids 

such as saliva, urine, cerebrospinal fluid, or blood. 

Lysis- Breaking down the membrane of a cell by viral, chemical, or physical means. 

MacConkey agar- A selective culture medium used for the isolation and differentiation of Gram-negative 

enteric bacilli.  

Matrix Assisted Laser Desorption Ionization Time of Flight Mass Spectrometry (MALDI-TOF MS)- A rapid and 

high-throughput method for microbial identification using specific protein signatures. 

McFarland Standard- References used to adjust the turbidity of bacterial suspensions so that the number of 

bacteria will be within a given range. This is done to standardize microbial testing. 

Minimum Inhibitory Concentration Testing (MIC)- A test used to determine the lowest concentration of an 

antimicrobial agent that will prevent visible growth of a microorganism. 

Oligonucleotide- Short single strands of synthetic DNA or RNA that serve as the starting point for many 

molecular biology applications. 

Oxidase test- A diagnostic test used to identify bacteria that produce cytochrome c oxidase, an enzyme that is 

part of the bacterial electron transport chain. 

Pathogenic- Capable of causing disease.  

Personal Protective Equipment (PPE)- PPE is clothing or equipment designed to be worn to protect a person 

from the risk of injury or illness. 

Polymerase Chain Reaction (PCR)- A technique used to amplify small segments of DNA into many copies. 

Post-Exposure Prophylaxis (PEP)- Treatment used to reduce the likelihood of acquiring an infection after 

potential exposure. 

Quantify- To count or express something using numbers. 

Quencher- Substances capable of absorbing energy from a fluorophore (such as a fluorescent dye) and re-

emitting that energy as either heat or visible light. 

Sapronotic- An infection that is a sapronosis, or a disease transmissible from the environment (e.g. soil, water, 

decaying plants). The organism must be able to grow and replicate in the environment. 

Seropositive- Showing a significant level of serum antibodies, or other immunologic marker in the serum, 

indicating previous exposure to the infectious agent of interest. 
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Spatial autocorrelation- The degree to which one object is similar to other nearby objects. It is the tendency 

for samples or sites that are close together to have similar values. 

Supernatant- The fluid lying above a precipitate/pellet following the centrifugation of a suspension. 

TBSS-C50- An enrichment broth often used for soil culture that contains a threonine-basal salt solution plus 

colistin at 50 mg/liter.  

Titer- A measurement of the amount or concentration of a substance in a solution. It usually refers to the 

amount of antibodies found in blood. 

Vortex- To mix (as the contents of a test tube) by rapid spinning or circular motion.  
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